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 Introduction 
REGIONS Multi-Physics X program is intended to solve Boundary Value problems of 

mathematical physics. The program is based on Fictitious Canonic Region (FCR) Method. FCR Method 

is a kind of Trefftz method. It uses geometric interpretation of Fourier solutions of the 

governing differential equations to select basis functions for the Trefftz method. One of the 

advantages of the Trefftz method is that the basis functions exactly satisfy the governing 

differential equations of the Boundary Value problem and approximately satisfy the boundary 

conditions. This advantage allows estimating the error of the solution only by the error of the 

boundary conditions which can be calculated easily for any problem. 
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 User Interface 
 The REGIONS X program user interface consists of four main windows (picture 1). 

 

 
 

Picture 1. REGIONS X program user interface. 

 

The Main Menu window contains menu strip to execute all program operations. 

The Main Screen window displays current graphical information and allows user to manipulate 

objects (select, unselect, get object information and so on) by mouse.  Screen view management 

includes the following operations: 

Zoom In, Zoom Out: Mouse Wheel Down, Up 

Pan: Mouse Left Down -> Mouse Move 

Rotate (about global coordinate system center): Mouse Right Down -> Mouse Move 

Zoom by window: Ctrl+Mouse Left Down -> Mouse Move -> Mouse Left Up 

(to escape Zoom by window while Mouse Moving just press Escape). 

If the Main Screen window is not visible – use main menu command System -> Graphics -> Main 

Screen Window to show the screen. Main Screen window has Popup menu that can be opened by 

pressing Mouse Right button on the window. 

The Main Object Inspector window allows user to change properties of objects. To set new property 

value just input (or select from list) new value and press Enter. Some complex properties (such 

as Colors, Vectors and so on) have their own Property Editors those can be executed by pressing 

button on the right of the property. Some properties are Read Only (such as ID of the object, 

Area of the surface and so on) and cannot be edited (but they are displayed by Object Inspector). 

The Main Object Inspector window is commonly shown when user executes Edit operations from the 

main menu. 

The Log window displays text information about user action results, solution progress and 

results, errors and hints. To make the Log window visible use main menu command System -> Log -> 

Show Information Log Window. 
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 Problem Solution Procedure 
Problem Solution procedure includes several stages which should be (commonly) implemented 

in the order as described below. 

 Creating new problem 

 First of all you need to create new problem. Use main menu command Problem -> New Problem. 

In the displayed form input the Name of the problem, select working directory (press button to 

use Directory Browser), select Problem Analysis from the list and press Apply button. New problem 

will be created and Geometry Model will be loaded. If problem file with the same name exists in 

the same directory – problem data information will be loaded from the file. 

 REGIONS X Analyses: 

 Thermal (steady, linear, 3D) 

 Electrostatics (static, linear, 3D) 

 Elasticity (static, linear, 3D) 

 Thermal Elasticity (static, linear, 3D) 

 Asymmetric Elasticity (static, linear, 3D) 

 Problem structure 

A REGIONS X Problem is a set of Models. A Model is again a set of objects of some Base 

type. For an example, Geometry model is a set of geometry objects – points, lines, surfaces and 

solids. Objects in model can be connected with other objects in the same model and in the other 

models. REGIONS X Problem consists of the following models: 

 Geometry model. 

 Material model. 

 Boundary model. 

 Fictitious model. 

 Result model. 

With each model user can make the following operations (menu strip Problem): 

Load model – model data is loaded into program memory and is ready to manipulate with the model 

objects (if the model file exists on the disk in the problem directory – model data is loaded from 

the file). 

Load model from – model data is loaded from the selected by user file and is ready to manipulate 

with the model objects. 

Unload model – model data is saved into model file in the problem directory and destroyed in the 

problem memory (so it is not accessible to manipulate with). 

Save model as – model data is saved into selected by user (so it is still accessible to 

manipulate with). 

Save model – model data is saved into the model file in the problem directory (so it is still 

accessible to manipulate with). 

 All problem data can be saved into files with the main menu command File -> Save Problem. 

With the main menu command File -> Save Problem as… all problem data saved into files with 

selected name in selected directory. If some model data is not loaded into the program memory and 

the model file exists – the file is just copied with the new name. Saving problem with the new 

name causes the name of the problem and the working directory changing. 
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 Creating Geometry model 

 Geometry model describes the geometry of the Boundary Value problem. Geometry model 

consists of a set of geometry objects – points, lines, surfaces and solids. 

The REGIONS X program uses Boundary Representation (BREP) technique, so to create a solid 

body a user must create all surfaces the body consists of. A surface can be created by existing 

lines or as new surface with its own parameters (for an example – parametric surface). A line can 

be created by using existing points or as new line with its own parameters (for an example – 

parametric curve). A point can be created by its coordinates or can be created on existing object 

(for an example – on a line). 

 All created geometry objects can be changed in any moment of geometry modeling. Use main 

menu command Geometry -> Edit ->… to change geometry object properties. Because (in common) 

geometry objects are connected with each other (for an example a straight line created by end 

points), changing one geometry object leads to changing the other, connected with it. 

 Each geometry object has its own Local Coordinate System (LCS). The parameters of Local 

Coordinate systems (translation, rotation and so on) are described relatively to the Global 

Coordinate system. Local Coordinate systems can be changed via translation, rotation and other 

operations. So the geometry objects can be changed via LCS manipulations too. 

 All geometry objects are created in the current Working Space. Working Space is simply an 

object representing a Local Coordinate System. To show Working Space use main menu command 

Problem -> Options (page Graphics). To manipulate Working Space use main menu command Problem -> 

Edit Working Space. Using Working Space for geometry object creation means just using the initial 

Local Coordinate System parameters for the object. 

 

Creating Points 

 Use main menu command Geometry Model -> Create -> Point to create a point by coordinates. 

Point window will be shown (picture 2). 

 
Picture 2. Point window. 

 

Input coordinates of the point in Local Coordinate System (the type of the system can be selected 

from the list). While inputting coordinates – the preview of the point is shown on the Main 

Screen. Press Create or Create+ button to create the point. 

 

Creating Lines 

Use main menu command Geometry Model -> Create -> Straight Line to create a line by two 

end points. Straight Line window will be shown (picture 3). 
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Picture 3. Straight Line window. 

 

Two points must be chosen to create Straight Line (so at least two points must be created 

before). Use Object Choice interface (picture 4) to choose points. 

 

 
Picture 4. Object Choice interface. 

 

Object Choice interface allows two ways to get object. Use >> button to choose object with Object 

Browser (picture 5). 

 
Picture 5. Object Browser window. 

 

When an object selected in the Object Browser it is highlighted on the Main Screen. Press Apply 

button to choose the selected object. 

Use … button to activate Object Picking by mouse. Object Picking will be activated and object can 

be chosen by mouse on the Main Screen. When Object Picking is activated the current object is 

highlighted on the Main screen while mouse moving. 

When both end points are chosen – the preview of the line is shown on the Main Screen. Press 

Create or Create+ button to create the line. 

Use main menu command Geometry Model -> Create -> Parametric Curve to create a freeform 

line by equations. Parametric Curve window will be shown (picture 6). 
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Picture 6. Parametric Curve window. 

 

Parametric Curve is a freeform line that determined by three equations 
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were 
1x , 

2x , 3x  - coordinates of the line point (in Local Coordinate System),  lF1 ,  lF2 , 

 lF3  - functions of Line Parameter l . The Line Parameter l  changes from 0 to 1.0. 

So, three functions of the variable l  must be given to create a Parametric Curve. User can input 
the function equations himself or can use Curve Library menu to select existing line equations. 

Curve Library menu contains also operations to add line equations into library, save equations in 

text files and read equations from text files. There are two libraries – Standard Library 

contains simple line equations (such as arc, elliptic arc and so on), Additional library contains 

more complicated line equations.  

When all three equations set – the line preview is shown on the main screen. If there are errors 

in equations – hints are shown in the Log window. Press Create or Create+ button to create the 

line. 

 

Creating Surfaces 

Use main menu command Geometry Model -> Create -> Two Line Surface to create a surface 

that starts with the first line and ends with the second one (so called ruled surface). Two Line 

Surface window will be shown (picture 7). 

Two end lines must be chosen to create a ruled surface. Use >> buttons to choose lines with 

Object Browser or … buttons to activate Object Picking by mouse on the Main Screen. 

When two lines are chosen – the preview of the surface is shown on the Main Screen. Press Create 

or Create+ button to create the surface. 



REGIONS Multi-Physics X User Guide 

Copyright © Sergey L. Gladkiy 

9 

9 

 
Picture 7. Two Line Surface window. 

 

 NOTE about surfaces: any surface has outer face and inner face (the former displayed on 

the screen with surface color and the last is darkened). The outer direction is where the normal 

to the surface points to, and the inner is inverse direction. When a preview of a surface is 

shown – the normal direction is displayed as an arrow. The surface direction can be changed to 

the inverse one by changing the property Inverse Direction value to the True (use command 

Geometry Model -> Edit -> Edit Surfaces to edit surface properties). 

Use main menu command Geometry Model -> Create -> Parametric Surface to create a freeform 

surface by equations. Parametric Surface window will be shown (picture 8). 

 
Picture 8. Parametric Surface window. 
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Parametric Surface is a freeform surface that determined by three equations 
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were 
1x , 

2x , 3x  - coordinates of the surface point (in Local Coordinate System),  vuF ,1
, 

 vuF ,2
,  vuF ,3  - functions of Surface Parameters  vu, . The Surface Parameters u  and v  

changes from 0 to 1.0. 

In the REGIONS X program surface parameters denoted as ]1[L  and ]2[L . So, three equations of 

variables ]1[L  and ]2[L  must be given to create a parametric surface. A user can write his own 

surface equations or get a predefined ones form Surface Library. 

When three valid surface functions are given – the preview of the surface is shown on the Main 

Screen. If there are errors in formulae – hints are displayed in the Log window. Use Create or 

Create+ button to create the surface. 

Creating Solids 

Use main menu command Geometry Model -> Create -> Solid Body to create a solid by existing 

surfaces. Solid Body window will be shown (picture 9). 

 
Picture 9. Solid Body window. 

 

Surfaces representing the boundary of the body must be selected to create a solid. Press Select 

button to select existing surfaces. The Object Selection window will be shown (picture 10). 

 
Picture 10. Object Selection window. 

With the Object Selection interface different selection methods can be used. Selection Type 

determines how objects will be selected. For an example, User Selection type will activate Object 

Browsing interface. By Name type allows object selection by their names and so on. Selection Mode 

determines how the selection is applied to the objects. For an example, From All mode means that 

selection is applied to objects directly. Add mode means that chosen objects are added to the 

already selected and so on. Surface selection by mouse can be activated by main menu command 

Geometry Model -> Select -> Select Surfaces by Pick.  

Selected objects are always displayed on the screen with Red color. When all required surfaces 

are selected – press Create or Create+ button to create the solid. 
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NOTE about solids: REGIONS X program modeling functions do not check the validness (connection of 

the surface edges, surface normal directions and so on) of the solids created. So, it is all user 

responsibility to check the solid validness. 

Use main menu command Geometry Model -> Create -> Parametric Solid to create a totally 

parameterized solid. Parametric Solid window will be shown (picture 11). 

 
Picture 11. Parametric Solid window. 

 

Parametric solid is a solid the boundary of which totally consists of parametric surfaces. All 

boundary parametric surfaces have the same parameters but different surface functions. So, to 

create a parametric solid three functions for each boundary surface must be given. A user can 

input his own surface equations or get predefined ones from the Solid Library. 

When valid surface functions are given – the preview of the solid is displayed on the main 

screen. If errors exist – the hints are shown in the Log window. Press Create or Create+ button 

to create the solid. 
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 Creating Boundary model 

 Boundary Model is a set of boundary objects those represent the boundary of the problem. 

All boundary objects can have boundary conditions associated with them. Actually, boundary object 

is a collection of boundary elements. Boundary elements are mainly used (together with boundary 

conditions) to compute Resolving System of Linear Algebraic Equations. 

 Boundary model creation includes two procedures – creation of boundary objects (mesh the 

boundary) and setting boundary conditions. Before begin operation with Boundary Model it must be 

loaded into program memory. Use main menu command Problem -> Load Boundary Model to get it 

loaded.  

Creating Boundary objects 

 The simplest and fastest way to create boundary objects (mesh) is to create uniform mesh 

and then change the number of boundary elements for individual boundary objects. 

 Use main menu command Boundary Model -> Create -> Uniform Surface Mesh to create uniform 

mesh for a set of selected surfaces. Uniform Surface Mesh window will be shown (picture 12). 

 
Picture 12. Uniform Surface Mesh window. 

 

Press the Select Surfaces button to select surfaces with the Object selection interface. When 

surfaces selected, input the number of boundary elements, select the form of elements (quads or 

triangles) and the type of elements. Press Create or Create+ button to create the mesh. 

 If mesh operation completes successfully – created boundary objects will be displayed on 

the Main Screen (to switch between model views – use Main Screen popup menu command Plot -> …). 

 NOTE about uniform mesh: it is not always possible to produce really uniform mesh for any 

geometry object because of its natural “nonuniformness”, so the uniform mesh tool does not always 

produce the desired result. 

 Use main menu command Boundary Model -> Create -> Uniform Surface Mesh for Solid to create 

uniform mesh for all surfaces of selected solids. 

 Use main menu command Boundary Model -> Edit -> Increase/Decrease Boundary mesh  to change 

the number of boundary elements. Increase Boundary Mesh window will be shown (picture 13). 

 
Picture 13. Increase Boundary Mesh window. 
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Press Select Boundaries button to select boundaries with the Object Selection interface. 

Selection by mouse picking can be activated by main menu command Boundary Model -> Select -> 

Select by Pick. After boundary selection input (or choose) the ratio of mesh increasing and press 

Increase or Increase+ button to remesh objects. 

 NOTE about boundary objects: geometry model objects can be edited in any moment of Problem 

Solution procedure, even when the boundary objects created for some geometry objects. But 

boundary model is not updated automatically when the target geometry is changed. To update 

boundary objects use main menu command Boundary Model -> Remove/Refresh -> ….  

Setting Boundary Conditions 

 In the REGIONS X program all Boundary Conditions can be set on the boundary mesh only. 

Different boundary condition types are accessible for different problem Analyses. Use main menu 

command Boundary Model -> Boundary Conditions -> Set Default Boundary Conditions to set default 

analysis boundary values on all boundaries (for an example, default boundary values for 

Elasticity Analysis are zero forces). 

 There are two classes of boundary conditions. Quantity boundary conditions assign some 

equation for a physical quantity. As an example – zero temperature on some boundary. As different 

physical quantities are valid for different Analyses – Quantity boundary conditions can be 

applied for certain Analyses only. Special boundary conditions are valid for all Analyses, but 

their meanings are different for different Analyses (as an example, symmetry boundary 

conditions). 

 Quantity boundary conditions can be Scalar or Vector. Scalar boundary conditions example 

is temperature value on a boundary, vector boundary conditions example is force vector value on a 

boundary. 

 To set temperature value on a boundary use main menu command Boundary Model -> Boundary 

Conditions -> Set Temperature. Set Temperature window will be shown (picture 14). 

 
Picture 14. Set Temperature window. 

 

Press Select Boundaries button to select boundaries with the Object Selection interface. Input 

temperature value function in the text box. All boundary value functions can include standard 

mathematical functions (sin, cos, ln and so on) and can depend on the boundary local variables 

( l  for lines and ]1[L , ]2[L  for surfaces) and space variables ][iLX  - Local System variables, 

][iGX  - Global System variables ( 3,1i ). A simple example of boundary value function - 

])2[**2sin( LXPi . Press Create or Create+ button to set given boundary conditions on the 

selected boundaries. Boundary value distributions will be displayed on the main screen. 

 To set (distributed) force value on a boundary use main menu command Boundary Model -> 

Boundary Conditions -> Set Forces. Set Forces window will be shown (picture 15). 
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Picture 15. Set Forces window. 

 

Press Select Boundaries button to select boundaries with the Object Selection interface. Input 

three force value functions in the vector function text boxes. Select the Vector Direction from 

the list. Vector Direction can be the following: Global, Local and Normal. Global direction means 

that vector functions determine vector component values in Global Coordinate System. Local 

direction means that vector functions determine vector component values in Local Coordinate 

System (for each boundary). Normal direction means that vector component values connected with 

the boundary object. For a surface, the first vector component is normal, the second is the first 

tangent and the third is the second tangent. 

Press Create or Create+ button to set given boundary vectors on the selected boundaries. Boundary 

vector distribution will be displayed on the main screen. 

 To set symmetry on a boundary use main menu command Boundary Model -> Boundary Conditions 

-> Set Symmetry. Set Symmetry window will be shown (picture 16). 

 
Picture 16. Set Symmetry window. 

 

Press Select Boundaries button to select boundaries with the Object Selection interface. Select 

the Symmetry Type from the list. Symmetry Type can be the following: Symmetric and Antisymmetric. 

Press Create or Create+ button to set Symmetry boundary conditions on the selected boundaries.  

 

NOTE about boundary conditions: boundary objects are not forced to have assigned boundary 

conditions. If a boundary object has no boundary conditions it is not taken into account in the 

Resolving System computing process. 
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 Creating Fictitious model 

Fictitious Model is a set of Fictitious Canonic Regions (FCR). FCR is a generic geometry 

region of simple shape, for which the general solution of governing differential equation can be 

obtained by Fourier method. So, each FCR has its own collection of Basis Functions satisfying 

governing differential equations. Thus, Boundary Model determines the set of basis function which 

will be used to solve constituted boundary value problem. In common, the set of Fictitious 

Canonic Regions should be geometrically close to the geometry of the boundary value problem. 

 Before starting any operation with the Fictitious Model load model into program memory 

with the main menu operation Problem -> Load Fictitious Model. 

Creating Fictitious Canonic Regions 

 Use main menu command Fictitious Model -> Create Regions -> Create FCRs to create 

Fictitious Canonic Regions. Create FCR window will be shown (picture 17). 

 
Picture 17. Create FCR window. 

 

Use Object Choice interface to get target solid body. Choose FCR category and select FCR type 

from the category. Input FCR center coordinates and FCR Local System rotation vector. Press 

Create or Create+ button to create FCR. The target solid will be immerged in the Fictitious 

Region and it will be shown on the main screen. 

NOTE about Fictitious Canonic Regions: Cylindrical and Spherical regions only totally realized 

and can be used to solve Boundary Value problems. ‘Solid’ prefix in FCR type name means 

Fictitious Region for Inner Boundary Value problem, ‘Hollow’ prefix – for Outer Boundary Value 

problem. 
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Setting Fictitious Canonic Region properties 

 To solve a Boundary Value problem successfully some properties of Fictitious Regions must 

be changed obligatory. Use main menu command Fictitious Model -> Edit Regions -> Edit FCRs to 

edit Fictitious Region properties. Existing Fictitious Regions will be shown in Object Inspector 

(picture 18). 

The main property is the number of basis functions for each Fictitious Region. For 

different Analyses different basis function set used and thus different properties must be 

changed. Specific Analysis properties can be recognized easily by prefixes: ‘T’ prefix used for 

‘Thermal’ analysis, ‘E’ prefix for ‘Electrostatic’ analysis and ‘U’ for ‘Elasticity’. The number 

of basis functions is denoted by ‘N’ property. So, for an example, to set number of basis 

function for Electrostatic problem – use ‘EN’ property. 

 

 
Picture 18. Fictitious Region properties in Object Inspector window. 

 

Another important property is ‘Z Period’ for Cylindrical Regions. Z Period must be more or equal 

than the Target Solid dimension in the Z direction (of local region coordinate system). 

 The ‘Basis Space State’ property allows to use basis functions of special kinds. There are 

the following basis space states: 3D – all basis functions, Symmetric – symmetric relatively to 

the local YZ plane functions, Antisymmetric - antisymmetric relatively to the local YZ plane 

functions, Z Symmetric - symmetric relatively to the local XY plane functions, Z Antisymmetric - 

antisymmetric relatively to the local XY plane functions, Plane – plane only functions, 

Axisymmetric – axisymmetric only functions. Not all Basis Space States are applicable to all 

fictitious Region types. For an example, Plane state is not suitable for Spherical Regions.  
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Solving Problem 

 Solving problem in FCR method means calculating basis function coefficients of Fictitious 

Canonic Regions. Before solution all models – Geometry, Boundary and Fictitious must be created 

(they can be loaded or unloaded). There must be at least one solid in the Geometry model, one 

boundary with boundary conditions in the Boundary model and one Fictitious Region in the 

Fictitious model to solve the problem. 

 Use main menu command Solution -> Solve to start solution procedure. Solution procedure 

includes several stages. The obligatory are computation of Resolving System of Linear Algebraic 

equations and solving the system. Solution can take significant time. The progress of solution 

procedure can be viewed in the Log window. Solution options can be changed. Use main menu command 

Problem -> Options (page Solution) to see and edit solution options.   

 If solution completes successfully, calculated basis function coefficients will be 

associated with the Fictitious Canonic Regions. 

 NOTE about solution: REGIONS X program implements “use if selected” technique in all 

calculation procedures. It means that if there is any selected object (boundary object, 

fictitious region and so on) the ONLY SELECTED data is participated in calculation, but if there 

is no selected object – ALL DATA included in solution. So, the best practice for common solutions 

– make sure there is no selected objects in models before solution started. 

Calculating and plotting results 

 After Solution procedure successfully completed, results can be calculated and plotted. 

Use main menu command Solution -> Calculate Results to calculate results. Calculate Result window 

will be shown (picture 19). 

 
Picture 19. Calculate Result window. 
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Different results are accessible to calculate for different Analyses. Choose Physical Area 

category and select result from the list. Press Apply button to calculate selected result. Result 

calculation process can take significant time. 

 After Result Calculation process successfully completed, the result can be plotted on the 

main screen in various forms. Use main menu command Result Model -> Plot Results to display 

results. Plot Result window will be shown (picture 20). 

 

 
Picture 20. Plot Result window. 

 

Select a result from the list (result indexes also can be selected for Vector and Tenzor 

results), select result plot style and boundary plot style and press Apply button. Selected 

result will be displayed on the main screen. 

 

Solving Test Problems 
 There are several test problems, integrated in the REGIONS X program. They can be used as 

demonstrations of total solution procedure for simplest boundary value problems. Use main menu 

command Help -> Execute Tests to see existing test problems. Select a test in the shown Select 

Objects window and press Apply button to run test problem solution. Test Execution process can 

take several minutes. Test execution progress can be viewed in the Log window. After test 

execution successfully completed, one of calculated result will be displayed on the main screen. 

 

 

 


